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Excel 2007-10 Ribbon Menu:
Excel 2007-10 have a different user interface from previous versions
of Excel called "the ribbon."   When properly installed the QI Macros
will appear in the far right part of the ribbon.

Click on QI Macros to reveal the QI Macros functions.  Any menu
with an arrow to the right has a pull down menu of further options.

Classic Menu Option for Excel 2007-2010
For users who prefer the Excel  2003 style menu,  see instructions to
change from the ribbon menu to  a "classic Excel 2003 menu"  at
qimacros.com/XL2007-switch-menus.html.

Mac and Excel 2000-03 Menu:
When properly installed on a Mac or older version of Excel, the QI
Macros will appear in the far right part of the menu. Click on QI
Macros to access all of its features.

Help, Technical Support & Other Resources
Technical support - qimacros.com/techsupport.html
FREE Training Resources: You can access videos, pre-recorded
webinars,  how to articles and a series of overview lessons at
qimacros.com/free-qimacros-training.html

About this User Guide
This booklet covers use of the QI Macros. It will not cover Excel,
SPC, or Lean Six Sigma.  See www.qimacros.com for other re-
sources addressing these topics.

To Install the QI Macros:
PC Installation Instructions:
From Download:

• Save the QIMacros230.zip file on your PC
• Extract files from the zip folder
• Double click on QI Macros2012Setup.exe to run the installa-

tion wizard.
From CD:

• Insert CD and  an installation page should automatically open
with a link to install in the top right corner.

• Click on this link to run the install wizard.
• If the install page does not open, right click on the CD drive and

select open.
• Double click on QIMacros230.zip to run the installation wizard.

Mac Installation Instructions:
From Download:

• Click on the  macintosh.zip file to download
• View your downloads and click on the QIMacros.mpkg file to

run the installation wizard.
From CD:

• Insert CD into your Mac and double click on the
QIMacros.mpkg file to run the installation wizard.

QI Macros purchased before November  2011:
• Copy the contents of the Excel Folder to Microsoft Office

(2001-11):Office:Startup:Excel .

Troubleshooting:
• If the QI Macros menu does not appear on your Excel menu,

see install help at qimacros.com/techsupport.html#install
• For  other problems with your  CD  or  download,  email:

support@qimacros.com.

The QI Macros is a Single User License.
You need to buy one license per computer.
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Run a Macro using the Menus
1. Input your Data into an Excel Worksheet: The simplest

format for your data is usually one column and one row of
labels, and one or more columns of data (e.g., samples).

Tips: Only select one column and row of labels. Each chart
requires a certain number of columns of data to run properly:

Required number of columns of data:
1 1 or more 2 2 or more

Pareto XmR Scatter Box & Whisker
Pie, Run Histogram Multivari

c, np, XmR Freq Hist
Levey Jennings EWMA u Chart XbarR
Moving Avg Cusum p Chart XbarS

Dot Plot XmedianR Hotelling Matrix Plot

2. Select Your Data: Use your mouse to click-and-drag to select
the data you want to graph. (Hint: don't select the whole column
or row, just the cells you want to graph.)

3. Select Your Chart: Click on the QI Macros pull-down menu
and select the Chart Wizard or the chart you want to run.

4.  Answer the Prompts: Most charts will prompt you for titles
and other information to complete the chart.

5.  Review and Save Your Workbook: When the macro is done
you will have a workbook with 3 sheets: your data, the chart
and an intermediate spreadsheet where you can view the
calculations. Don't forget to save your workbook.

Date/Labels

Defects/Samples

Tools in the QI Macros
Introduction

The QI Macros SPC Software for Excel consists of five parts.

1. Macros Control Charts, Histograms, Line, Run, Scatter, Pareto,
Bar, Pie, BoxWhisker, Multivari

2. Templates SPC Charts, Flowcharts, Fishbones, Gage R&R, DOE
& QFD, FMEA & PPAP, Value Stream Map

3. Statistics ANOVA, F test, t test, Chi Squared, Correlation,
Regression, Sample Size

4. Data PivotTable Wizard, Count Words, Stack/Restack
Tables, Get Sample from Table, Paste/Link Transpose

5. Wizards Chart, Control Chart, PivotTable and Statistics

90% of common problems can be diagnosed with control
charts, pareto charts, and Ishikawa diagrams. The QI Macros
can be used to create all of these charts, graphs, forms and tools.

Excel Workbooks—Entering your data.

Other software packages make you transfer your Excel data into
special tables, but not the QI Macros. Just put your data in a standard
Excel worksheet. The simplest format for your data is usually one
column of labels, and one or more columns of data.

Sample Data: The QI Macros loads sample data on your

computer at  c:\qimacros\testdata. There is  sample data for each
chart. Use this data for examples of how to set up your data and to
practice running charts.

Watch "how to videos" for many QI Macros tools at
www.qimacros.com/qimacros-video-tour.htm



© 2012  Jay Arthur 7 QI Macros© 2012  Jay Arthur 6 QI Macros

Common Error Messages:
Many charts require more than one column of data. If you only select
one column of data and then select one of these charts you will
receive the following error message.

The u chart assumes that your defects column is to the left of your
sample size column.  If the columns are reversed (larger #s on the
left), the macros will ask you if the left column is the sample size.

Formatting Excel Charts:
Once you create a chart,  you can use any of Excel's menus and
commands to enhance or format your chart. Just select the item to
format and then right click to view the  options available.

Add Text boxes, arrows or other - Use Excels drawing toolbar to
add text boxes, arrows or other symbols to your chart. To view the
drawing toolbar, select View/Toolbars/Drawing. The drawing toolbar
usually appears on the bottom of the worksheet.

Put two charts on the same worksheet - Click on your chart, then
select Edit-Copy.  Then click in the destination  worksheet and select
Edit-Paste.

For Other Chart Options - Click on the Chart pull down menu.

See www.qimacros.com/free-excel-tips/format-charts.html for further
information on how to format your charts.

Data Format & Selection Tips
1. To highlight cells from different columns (as shown). Click

on the top left cell and drag the mouse down to include the cells
in the first row or column. Then, hold down the Control Key,
while clicking and highlighting the additional rows or columns.

2. You may also use data in horizontal rows. Click on the top
left cell and drag the mouse down and right to include the cells in
the horizontal rows.

3. Numeric data and decimal precision: Excel formats most
numbers as "General" not "Number". If you do not specify the
format for your data, Excel will choose one for you. To get the
desired precision, select your data, choose Format-Cells-
Number and specify the number of decimals:
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Summarize Your Data
The QI Macros PivotTable Wizard or Excel's PivotTable tool will
help you summarize your data just about any way you want.

1. To use the PivotTable Wizard, click on up to four column
headings. Otherwise, select the labels and data to be
summarized, in this case,  event codes by
region. Many processes and gages produce
one code or measurement each time an event
happens. These often need to be summarized
to simplify your analysis.

2. From Excel's menu, choose: Data-Pivot Table. Follow the
PivotTable Wizard until you get a screen like one of these:

3. Click and drag the data labels into the appropriate area of
the  PivotTable to get the summarization you want:

4. To change how the data is summarized, use the PivotTable
Wizard or double click on the top left-hand cell. For online
tutorials, Google "Excel PivotTable".

5. Select labels and data tp draw charts using your data.

Data Transformation Tools
The QI Macros Data Transformation Tools help you analyze your
data and reorganize it to run a chart.

Pivot Table Wizard
The QI Macros PivotTable Wizard  makes it easier to run Pivot
tables. Just select up to 4 columns of data and select the wizard.

Count Words in a Table
Just select your data and the Word Count function will count the
number of times a word or two word phrase appears in your data.

Stack/Restack /Restacking
This function increases or decreases the number of columns your
data is organized into.  It can take one column of data and "stack" it
into multiple columns or it can take multiple columns of data and
restack it into one column.  It can also convert 2 columns to 3 or 4
columns to 2, etc. Just select your data, then click on stack restack
and answer the prompt about how many new columns you desire.

Paste Link/ Paste Link Transpose
Excel lets you paste link and paste transpose but it doesn't let you do
both at the same time. Use these functions to link your data to a QI
Macros Fill-in-the-Blanks Template.  Update your data sheet and
the template and chart are automatically updated.  Use these function
to build dashboards.

Box Cox Transformation
Box Cox Transformation multiplies the selected data by a transfor-
mation factor. The purpose is to transform non-normal data into data
that is closer to normal.

See qimacros.com/free-excel-tips/data-transformation.html for
further information on these tools.
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Create Pareto Charts:
1. Highlight the labels and one or more columns of data (you

will get a separate pareto for each data column): labels in
the left-hand column, data in the right-hand column.

2. From the QI Macro Menu bar select Pareto Chart.  If you
have more than 9 data points, the macros will ask you how
many bars you want before you summarize the miscellaneous
ones into an  "Other"  bar. Input the number of bars and then
click "OK."

Sample Pareto chart with an "Other" Bar.

If you want to add data, consider using the Pareto template instead
of the macro. Watch video of a pareto chart being created at
qimacros.com/qiwizard/pareto-chart-video.html

Pareto charts are a
combination line chart
and bar graph. They help
narrow your focus to
simplify problem solving.

QI Macros Wizards
The QI Macros is the only Six Sigma SPC software that that provides
Wizards to automatically choose charts based on your data.

We have found that beginning and even experienced Six Sigma users
aren't always sure what chart or tool to use. Because users select their
data before they draw a chart or run a statistic, the QI Macros can
easily determine the best charts, statistics or organization for the data.

The QI Macros have several wizards to assist in choosing the right
chart or statistic:

Chart Wizard - chooses the right charts for your data:
descriptive statistics, pareto charts, control charts, histograms,
box and whisker charts, scatter charts, etc.

Control Chart Wizard - chooses the right  control chart for
your data from: c, np, p, u, XmR, XbarR, or XbarS.

PivotTable Wizard - creates a Pivot Table when you select
up to four columns of data.

Statistics Wizard - to automate hypothesis testing: normality,
F test, t test, ANOVA, etc.

1. Highlight the labels and data to be graphed, then click on the QI
Macros menu and then select the appropriate wizard.

2. The QI Macros Wizards will automatically draw all of the graphs
or statistics required. The PivotTable will summarize the data
based on the number of columns selected.
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Create a Box &Whisker:
1. Highlight the labels and data to be graphed.

2. From the QI Macro Menu bar select Box and Whisker.
The  Box and Whisker macro will ask whether your data is
grouped in rows or columns. The data above has 18 rows and 4
columns.

Create a Multivari Chart:
The Multivari Chart summarizes data based on labels (A:C)
and plots the averages and data points:

This chart requires
2 or more columns
of data.

Box and Whisker
plots help show the
dispersion of data
over time. Each bar
is like a histogram
turned on its side.

Graph if select by Rows Graph if select by columns

Create a Scatter Chart:
1. Highlight the labels and data to be graphed.

2. From the QI Macro Menu bar select "Scatter Diagram."

3. The macro will create a
scatter diagram with  y and
R2  metrics.   Other metrics can
be found on the scatter data
worksheet.

Watch video at qimacros.com/
qiwizard/scatter-plot-video.html

Create a Matrix Plot:
You can  also use a Matrix Plot to evaluate the correlation and cause
effect between two or more variables.

Scatter charts can help confirm your
suspicions about cause and effects.

Scatter charts require  two columns of
data.

If R2 >.8,  most statistics books imply
there is a strong correlation.
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5. Then, the macro will draw the graph for you.

6. To move the USL or LSL arrows or text boxes:

Arrows: Click on each arrow and drag it to the appropriate
position. To extend an arrow, click on it, then click on the
handle at either end and extend the arrow.

Text: Click on each text box and drag it to sit on top or
beside its corresponding arrow.

7. To revise the process capability analysis, switch to the
Histdata sheet and change the upper and/or lower specification
limits. Excel will recalculate Cp ,Cpk and other metrics and
update the contents of the text boxes on the chart. You can also
change the # of bars, class width and beginning point.

For information about  histogram calculations in the QI Macros, see
qimacros.com/pdf/histogram-manual-calcs.pdf.

Watch a video showing how to create a  histogram at
qimacros.com/qiwizard/histogram-video.html.

Create a Histogram:
1. Make sure the cells are formatted to the correct decimal

precision. Right click on cells and select Format-Cells, select
Number and specify the number of decimal places you want.

2. Highlight the labels and data to be graphed (a  minimum of
20 data points is recommended). Click on the top data cell and
drag the mouse down to include just the data cells. Tip: Do
NOT sort your data before running a histogram.

3. From the QI Macro Menu bar, select either the histo-
gram  or frequency histogram. You will be prompted for
upper and lower spec limits and the approximate # of bars to
display. Click OK to use the defaults or enter your own.  For
one-sided or unilateral histograms, click Cancel if there is no
USL or LSL.

4. Single Column of Data? If you select a single column of data,
the histogram will prompt for subgroup size (default=1, but
some gauges produce five samples per subgroup).
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Create a c, np, p or u Chart:
Attribute charts track the number of defects in a sample.

1. Highlight the labels and data to be graphed (as shown).

2. From the Control Charts Menu, select "c, np, p or u
chart". The np chart will prompt for  a sample size if you did
not include it in your selection.

See also: qimacros.com/control-charts/show-hide-sigma-lines.html
qimacros.com/control-charts/p-and-u-chart-formats.html

c or np charts p charts u charts

c or np charts have
straight UCL and LCL.

p and u charts can
have UCL and LCL
lines that vary with the
sample size.

Control Chart Wizard:
Choosing the right chart depends on your data–attribute
(counted) or variable (measured)–and the sample size.

Number in Sample
Type of data 1 2-or-more Varies
Fraction Defective np p
Number of defects c u
Time, length, weight, $ XmR XbarR
        (Measured) XbarS XbarS

You can select the chart yourself or let the Control Chart
Wizard analyze your data and select it for you.

To use the Control Chart Wizard:

1. Highlight the labels and data to be graphed. From the QI
Macro Menu bar, select Control Chart Wizard.

2. The wizard will analyze your data and select the correct chart for
you.  If it needs to determine between a p and a u chart it will
prompt you to answer the following question:

If you answer  No, it will run a p chart. If you answer  Yes, it will
run a u chart.

Resources for selecting your own chart include:

• The SPC Quick Reference Card at qimacros.com/sustainaid.pdf

• Free article at qimacros.com/free-excel-tips/choosing-control-
charts.html

• The  1 hour SPC Simplified Training Video at qimacros.com/
spc-simplified-training-video.html
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4. Next, the macro will draw the X chart. If the Range Chart
looks stable and the X chart is stable, then the process is stable.

5. From the File Menu, select Save to save the graph with
your workbook.

Create Stair Step Limits:
Before you run any control chart you can insert a blank row in your
data where you know a process change occurred, the QI Macros will
calculate separate UCLs and LCLs for each group of data giving you
"stair-step" control limits.

For more information  about control chart menu features see
qimacros.com/qimacros-excel-tips.html#menu

Create X and R Charts:
An X chart shows process performance using continuous data
(i.e., time, length, weight, money, etc.)

1. Highlight the labels and data to be graphed. You will need
20 or more data points to get a good graph. Your data should
look like this:

2. From the QI Macro Menu bar, select "XmR, XmR
Median R,  XmR Trend, XbarR, XbarS, or Xmedian
Chart." The macro will create a new worksheet and begin
calculating the X and R values, control limits, and averages.

3. The macro will first draw the Range Chart. If the R chart
looks unstable, then the process is unstable.

XmR XbarR and XbarS
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Chart Tools Menu
After you run a  chart, the QI Macros give you additional tools to help
update and analyze your data using the Chart Tools menu.  To access
this menu, click on a chart and then click on the QI Macros Chart menu.

Chart Menu in Excel 2007 - 2010

Chart Menu in Excel 2000 - 2003 and Mac versions of Excel

Add Data toCharts:   Click on the chart
datasheet (i.e. cdata) and input  new data
points. Then click on the chart. Next click
on  the chart tools menu and Add Data.
Enter the number of rows to add and then
click OK.

Add Target Line to Chart: Click on the chart menu and then Add
Target Line.  You will be prompted for the series label (e.g. Target,
Spec Limit, Goal, etc) and the value where you want the line drawn.

 Analyze Stability: After you add new data, delete a point or show a
process change  on a control chart , you should re-run stability analysis.
To do so, simply click on Analyze Stability on the Chart  Tools menu.

Control Chart Stability Rules
When you run a control chart, the QI Macros will show unstable points
as diamonds and conditions in red. They will also show 1 and 2 sigma
lines for evaluating stability.  The QI Macros use stability rules defined in
Montgomery's Introduction to Statistical Quality Control 4th edition.

You can change the sigma lines, stability  rules or  p/u chart limit formats
(flat vs wavy) as follows:

1.  Click on the QI Macros Menu, then Control Charts then
Control Chart Rules.

2.   Click on the stability rules you want to use.  The stability
rules for each selection are:

3.  To hide sigma lines or change p/u chart formats click on the
appropriate selection.

4.  Any changes you make will be saved to the QI Macros and
will be applied to all of the charts you run.  To change the rules
back, simply click on Control Chart Rules and select Default rules or
Show Hide 1 and 2 sigma lines or p/u chart format. If you want to
customize the stability and chart format rules even further, see
qimacros.com/free-excel-tips/control-chart-rules.html.
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Control Chart Templates
You can also use  Fill-in-the-Blanks templates to create control charts.

1. Click on the QI Macros Menu, Fill-In-The-Blanks Templates and
then SPC Charts. Then select the desired template.

2.  Each template is made up of several worksheets (average, median,
rolling, fixed, short run etc.) See further info and descriptions at
qimacros.com/qiwizard/control-chart-template.html

3.  Just input your data in the yellow area and the points will be plotted
on the chart as you enter them.  You can also cut and paste into the
yellow area or link the cells to another spreadsheet.

Add New Data: Templates default to 50 data points. To add more
points, copy down the formulas (they are hidden behind the charts), then
click on the chart and select Add Data to Control Charts on the Chart
Tools menu. Input the number of points you want to add.

Delete a Point: simply delete the point from the input area.

Show Process Change: enter the Excel row number
corresponding to the data point where the  Process Change
occurred in the process change box to the right of the chart.

Analyze Stability:  click on the chart and then select Analyze Stability
on the Chart Tools  menu.

Control Chart Tools Menu
Delete Point: Deletes a point from a control chart and the calculations.

Ghost Point: Deletes a point from the calculations but leaves it on the
chart.

Show Process Change : On the chart click on the point where the
process change occurred.  Now click on the Tools menu and select
Show Process Change. The macros will calculate a new set of control
limits starting at the point you selected. The UCL, CL and LCL values
will be updated to show the new limits.

Stability Analysis: Make sure you re-run stability analysis  after you
do any of these functions.

Show/Hide 1-2 Sigma Lines:  Just click on this selection to add  or
delete 1 and 2 sigma lines from your chart.

Recalculate Control Limits After you Add New Data (optional):
Control limits are calculated with the data you selected when running the
macro. If you want to recalculate control limits after you add new data:
Add new data tothe chart. Next, click on the first data point on the chart
and select Show Process change on the menu.

Since this function recalculates control limits using the point selected and
every point to the right, it will recalculate your control limits using all of
your data including the new points. For more info about  all of these
features see qimacros.com/qimacros-excel-tips.html
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Create a Flow Chart:
1. The first step of managing any process is to define its flow.

Select Fill-in-the-Blanks Templates, Flowcharts and Fishbones,
then choose the Flow Chart template.

2. From the File Menu, select Save As to store the template
under a new name.

3. Copy and paste the existing text, boxes, diamonds and arrows
to create your flow chart. Change the text.

4. Excel 2000-2003: Select VIEW-TOOLBARS- DRAWING.
In Excel 2007-2010, select Insert, Shapes. Use Autoshapes to
find more drawing shapes and to connect the boxes and dia-
monds as you would with any flowcharting tool.

Fill-in-the-Blank Templates:
The QI Macros contain 90 + templates including a balanced
scorecard, flowcharts, fishbones, FMEA, QFD, DOE, GageR&R,
PPAP, Value Stream Mapping, Time Tracking and more. There are
also templates for most charts including control charts, histograms,
scatter, box whisker and pareto charts.

Fill-In-the-Blanks Templates in Excel 2007-2010: Click on QI
Macros, then look for Fill-in-the-Blanks Templates.  Click on each
sub menu to get a list of templates in that category.

Fill-In-the-Blanks Templates in other versions of Excel: From
the QI Macro Menu bar, choose Fill-In-The-Blank-Templates.
Then choose a sub menu to get a list of templates in that category.

Many templates including the Balanced Scorecard, FMEA, Gage
R&R, DOE and PPAP Forms are really several different templates
(worksheets) in one workbook. To access each worksheet just
click on the worksheet tab.

Our Six Sigma Ezine archives contain articles about many of these
tools at qimacros.com/six-sigma-articles.html.
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   Create a QFD Template:
1. From the QI Macros, select Fill-in-the-Blanks Templates,

then DFSS. Choose the QFD House of Quality.

2. From the File Menu, select Save As to store the template
under a new name.

3. Enter the "whats" and "hows" for the diagram.  Insert
columns and rows as required to expand the matrix. Then enter
importance and interactions.

4. Excel 2000-2003: Select VIEW-TOOLBARS- DRAWING.
In Excel 2007-2010: Select Insert-Shapes. Use Autoshapes
to draw all competitor scores.

For articles about QFD, see qimacros.com/six-sigma-articles.html

To sign up for our Six Sigma ezine, send an email to: six-sigma-
ezine@aweber.com, Subject = "sign up"

W
ha

t

How

Create an Ishikawa:
Excel may not be the best tool to do this with, but you can easily
draw Ishikawa diagrams with the drawing tools.

1. Select Fill-in-the-Blanks Templates, Flowcharts and
Fishbones, then  choose the Ishikawa, or fishbone diagram.

2. From the File Menu, select Save As to store the template
under a new name.

3. Use the text and arrow tools from the Drawing Tool Bar to add
arrows and causes. (To see the tool bar, select: View/Options-
Toolbars-Drawing.) In Excel 2007-2010, select Insert-Shapes.

Use the Ellipse tool to circle root causes.

Each line, box, text or circle is called an
"object." Objects can be grouped
together to form a single object or
moved in front or behind each other
using the Drawing Tool. To copy the
fishbone and place it in another docu-
ment, use Cntr+Shift + A to select all
objects, then Edit-Copy.
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Design of Experiments (DOE):
DOE can help you shorten the time and effort required to
discover the optimal conditions to produce Six Sigma quality in
your product or service.

1. On the Fill-In-The-Blank Templates menu select DFSS,
then DOE. Next select the Taguchi or Plackett Burman
template you want to use.

2. Input your factors and the low-high settings for each factor. In a
two factor test it might be: Time: 30 minutes & 45 minutes and
Temperature: 325 degrees and 375 degrees.

3. Use the +/- values in the orthogonal array to guide your
test of every combination. In a two factor test it would be:
High ++ (45 min & 375 degrees), Low - - (30 min & 325
degrees), In between + - (45 min & 325 degrees) and - + (30
min & 375 degrees).

4. Input your results into the yellow input area and observe
the interactions. See the DOE article at qimacros.com/free-
lean-six-sigma-tips/design-of-experiments.html

   Create a GageR&R:
1. From the QI Macros, select Fill-in-the-Blanks Templates,

then DFSS, DOE, MSA. Choose the GageR&R template.

2. From the File Menu, select Save As to store the template.

3. To conduct a study you'll need: five to ten of the same part
from one batch or lot (these must span the range or tolerance you
are trying to measure), at least two appraisers and a minimum of
two measurement trials, on each part, by each appraiser. If you
have references or specification tolerances, enter them.

4. Evaluate GageR&R, graphs, and data to identify where to
improve your measurement system.

Gage R&R System Acceptability

• % R&R<10% - Gage System is Okay (Most variation caused by
parts, not people or equipment)

• % R&R<30% - May be acceptable based on importance of
application and cost of gage or repair

• % R&R>30% - Gage system needs improvement
(People and equipment cause over 1/3 of variation)

See free articles at qimacros.com/qimacros-excel-tips.html#msa or
consider our Gage R&R whitepaper at qimacros.com/products.php
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Statistical Analysis
Six Sigma utilizes analysis tools like ANOVA, regression, and other
tests. You can now access these tools through the QI Macros.

1. Select data for analysis. Some tools, like Anova can take
many columns. Others, like Regression use two columns. A few
only use one column. Data must be in columns for these tools to
work. See c:qimacros/testdata/anova for examples.

2. From the QI Macros, choose
Stat Wizard to automatically
analyze normality, variation and
means. The Wizard will base it's
analysis on the data selected.

3. Or from the QI Macros,
choose ANOVA and Analysis
Tools. A number of different
statistical tools will be displayed.

4. Select the appropriate statisti-
cal analysis, and click OK.
Answer any of the prompts
(defaults are provided) and the
QI Macros will perform the
analysis you've requested.

5. The QI Macros will also interpret the results for you.  For
example, they will tell you to Reject or Accept the Null Hypoth-
esis and whether the Means or Variances are the same or
different.

For  more help go to:

qimacros.com/qiwizard/statistics-wizard-excel.html

 qimacros.com/qiwizard/hypothesis-testing-excel.html

Control Chart Dashboards
These new  templates will automatically create Control  Chart Dash-
boards  for you.

1. Click on the QI Macros menu (see below examples) and select
Control Chart dashboards. Then select the XmR or  c, np, p u
Dashboard.

2. A template will open.  Each template has an instructions sheet, a
data input sheet, and a sheet for each available chart.

3. Input or cut and paste your data into the columns in the Data
Sheet. Each column or set of columns creates a different chart.
The XmR dashboard has cells for USL/LSL as well.

4. Now click on the sheet for the desired chart.  You will see a chart
created from the first data set.  Click on the previous and next
arrows to view charts for each data set.

5. If you want to create a dashboard with charts for all data sets,
simply click on the Create Dashboards icon.

6. To add new data to the templates or the dashboard charts just
add data to the Data Sheet and click on the Refresh Data  or
Refresh Data with Stability Analysis icon.

See also qimacros.com/qiwizard/control-chart-dashboard.html

Excel 2000 to 2003 Excel 2007-2010Excel 2007 Classic
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Installation Trouble Shooting
QI Macros Menu  is not visible in Excel OR qimacro.xla
could not be found message .  Excel has disabled  the QI Macros
files.  To fix the issue simply re-enable the file per these instructions:

Excel 2000  - 2003: In Excel click on Help/About Microsoft  Excel
then click on Disabled items in the lower right corner. Enable any
disabled QI Macros files.

Excel 2007-10: In Excel click on the office icon in the upper left
corner, then Excel Options then Add ins on the left. Click on the
arrow next to Manage and select Disabled Items. Click Go to see
disabled items. If th QI Macros are disabled, enable them.

Create Excel Charts:
Excel's chart wizard enables you to run various charts. We have
taken the most popular of these and made them easier to use.  To
run a line, bar, pie, spider (radar) or line column chart:

1. Highlight the labels and data to be graphed, then click on the QI
Macros pull down menu,   Excel  Charts and then select the
chart you want to run.

2. The QI Macros will prompt you for  the graph title, and the X
and Y Axis titles as appropriate.

Create Run Charts
A run chart is a line graph of your data and an additional line repre-
senting the average or median of your data. Create a run chart by
selecting your data and selecting run chart from the QI Mac-
ros pull down menu, then select Average or Median.
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Customizing & Enhancements
The QI Macros are written in VBA.  We can create custom Excel
applications for you.  Just let us know what you need and we will send
you a free quote.

Simple Turnkey Systems in Excel
Is there something you want to do in Excel, but you just don't have time
to figure it out? Is there something the macros could do to help you
make analysis more easy?

Here are just a few of the applications we've developed for other
clients in Microsoft Excel:

Healthcare Dashboards and Scorecards

Do-it-yourself Dashboards and Scorecards

Customer Wait Time Tracking

Measurement Dashboards

Automated roll-up of various data and charts

For a free quote, send your Excel data and charts to
info@qimacros.com. Describe what you want to accomplish and we
will send you a free estimate.

Fill in the Blanks Dashboards Systems.   These systems contain a
place to define your measures and color coding criteria, a data entry
sheet, a color coded scorecard and a dashboard with control charts.
See our 10, 20 and 30 Measure Dashboard Systems at

qimacros.com/dashboard-scorecard-for-excel.html.

Lean Six Sigma or QI Macros On-site Workshops Consider
bringing Jay on-site to train your employees. Call (888) 468-1537 to
schedule a class or view these pages for further information:

QI Macros One Day Workshop - qimacros.com/qimacros-
training.html

Lean Six Sigma One Day Workshop - qimacros.com/lean-six-sigma-
workshop.html

Other Common Questions
How do I set up my data? See test data files loaded on your
computer at c:\qimacros\testdata.

Run Time Error... These messages mean there is a problem
with your data. Either your header looks like data, your data
looks like text or you have selected blank cells.

To uninstall the Macros: Delete the qimacros.xla file and the
QIMacros2010menu.xlam file (Excel 2007-2010 only)  in
Excel's startup folder at

c:Programfiles/Microsoft Office/Office(10, 11, 12,14)/XLStart:

Technical Support
Most tech support questions are  answered at:
         qimacros.com/techsupport.html

If you're still having problems email your Excel file and
problem to: support@qimacros.com. Include the version
number and service pack of Excel, and QI Macros version.

You can also call our tech support line at 888 468 1537 on
Monday to Friday  from 8:00 am to 5:00 pm Mountain time.

QI Macros questions are free, however, there is an addi-
tional fee for SPC and Excel coaching and help.

If you get Windows or Excel errors, check the Microsoft
knowledge base at support.microsoft.com

Other Resources
Free Training at  qimacros.com/free-qimacros-training.html.

Email qimacros@aweber.com for a FREE supplemental course
on the QI Macros.

Disclaimer: These macros are not infallible. Given  bad data, they
will halt. Simply press Halt or Continue.
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Free Webinars and Training
Free Monthly One Hour Webinars: Great overview of the key
functions in the QI Macros. Check dates and register at: qimacros.com/
webinars/webinar-dates.html

Free Lean Six Sigma "Money Belt" Training:  www.lssmb.com

Free email lesson series and monthly tips and tricks newletter.
Sign up by sending an email to qimacros@aweber.com

Free articles and tips and tricks  archive at qimacros.com/qimacros-
excel-tips.html

Free QI Macros Video Tour at qimacros.com/qimacros-video-
tour.htm

Other Products and Services
We offer books, training videos and on-site training on:

              Lean                   Six Sigma                     SPC

Check out our products page at qimacros.com/products.php

Download a product brochure at qimacros.com/qiflyer.pdf

See on-site training options at qimacros.com/lean-six-sigma-training.html

Order Options:
Online: at qimacros.com/products.php
FAX: POs to (888) 468-1536 or (303) 756-3107
Call: (888) 468-1535 or (303) 757-2039
Email: orders @qimacros.com

Tech Support: (888) 468-1537 or  (303) 756-9144 or
support@qimacros.com

KnowWare International Inc dba Lifestar
2253 S. Oneida St. Ste 3D
Denver, CO 80224


